Introduction to Contact Center

Interaction Desktop is an interaction and communications manager for desktop or laptop PCs, and offers more functionality than your office telephone. Use it to manage all your department communication, including phone calls, conference interactions, voicemail, etc.

This guide is designed to provide an introduction into the Interaction Desktop and your most basic tasks. For more information as well as instructions for using the other extensive features your client offers, select Interaction Desktop from the Help menu within the Interaction Desktop interface.

Contact Center is an Automated Call Distribution (ACD) phone system. ACD systems are responsible for routing a specific interaction to an agent qualified to handle that type of interaction. In Contact Center, this is done by routing the call to a workgroup queue. A workgroup is an entity which is configured for a specific purpose. Call Center Agents are assigned to each workgroup as its members.
Need Help?

You can get help by clicking Interaction Desktop from the Help menu. The Help window displays the currently selected help topic along with Table of Contents, Index, and Search tabs.

The table of contents (figure on right) lists things you can do with Interaction Desktop. Index and Search tabs are also available to help you find keywords mentioned in the help topics.

Click the Index tab to search for specific keywords and phrases, or choose from a list of keywords listed within the Index.

Click the Search tab to find topics that contain any word, not just keywords.
Starting Interaction Desktop

There are multiple ways to start the Interaction Desktop.

1. You may have an Interaction Desktop shortcut on your computer desktop. If so, you can simply double-click the shortcut to start the program.

2. You can also access the Interaction Desktop from the Start Menu. Start > Programs > Interactive Intelligence > Interaction Desktop
Adding the Interaction Desktop to your “Startup” Folder

If you would like to add the Interaction Desktop to your “Startup” folder, so that the client is automatically launched every time you boot up your computer, here are the steps you need to follow:

1. Click on the Windows Start button and select All Programs > then “right-click” on Startup.
2. Select Open. That should open the Startup folder.
3. Find the Interaction Desktop shortcut icon on your desktop > then “right-click” the icon and select Copy.
4. Go back to the Startup folder (that you opened in step 2) > click on Edit (on the top menu bar) > Select Paste. That should have added a copy of the Interaction Desktop shortcut icon to your startup folder.
5. Close the Startup folder.
Logging In

The Interaction Desktop Login dialog box appears.

Note: For users whose desktops login to the University Active Directory please follow these login steps (note: HBS and UHS are examples of customers who do not login to University Active Directory. These customers should follow the second set of login instructions below).

1. Use Windows Login Authentication:
   Uncheck the box. Use your HarvardKey linked email and your HarvardKey password to login. Check the Save Password box to save your password for future log ins.

2. Server:
   This will contain the name of the CONTACT CENTER server you should connect with. If it is not filled in, use contactcenter.harvard-phone.harvard.edu.

3. Station Type:
   This is the type of station you are using to run IC. Choose <“remote station>” and put in the telephone number of the phone set you will be answering calls from.
Note: For users whose desktops login to their own local Active Directory please follow these login steps (note: HBS and UHS are examples of this type of customer).

1. Use Windows Login Authentication:
   
   **Uncheck** the box. Use University\ADID for the User name and your HarvardKey password to login. **Check the Save Password** box to save your password for future log ins.

2. Server:
   
   This will contain the name of the CONTACT CENTER server you should connect with. If it is not filled in, use contactcenter.harvard-phone.harvard.edu.

3. Station Type:
   
   This is the type of station you are using to run IC. **Choose <“remote station>”** and put in the telephone number of the phone set you will be answering calls from.
Once you have entered the correct information click the Log On button.

Basic Interaction Desktop Configuration

The Interaction Desktop initially opens in a basic configuration which consists of the Number field at the top of the screen, the My Interactions tab which is your user queue, the Call History tab which as the name implies shows your inbound/outbound call history, a call control bar which is used to perform actions on your interactions, a status drop down box and a company directory with a directory control bar.

Note the icon of the person in the blue shirt down in the lower right corner of your screen. This area of your task bar is called your system tray and if the Interaction Desktop is running this icon will be present in your system tray.

By default, this icon will appear this way anytime you are Available for an interaction. This icon may change its appearance based on your status.

The icon can also be clicked to open the Client window if you close it.
My Interactions

The My Interactions page shows the current interactions in your user queue. The My Interactions page displays the following information about each interaction:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue</td>
<td>The workgroup associated with the call. This field will be blank when a call is not associated with a workgroup (i.e. calls to an user extension or DID). For users who are not agents in queues, this field is normally blank.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the person or organization with whom an Interaction Desktop user is speaking. This field is populated with whatever the local telco provider is sending the CONTACT CENTER system (i.e., City and State or Caller’s Name).</td>
</tr>
<tr>
<td>Number</td>
<td>The telephone number of the person with whom an Interaction Desktop user is speaking.</td>
</tr>
<tr>
<td>Duration</td>
<td>The call length.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the call. For example: Connected, Hold, Remote Disconnect (caller hung up first), Local Disconnect (you hung up first).</td>
</tr>
<tr>
<td>Interaction ID</td>
<td>The interaction’s identification number used for troubleshooting. Often times your IT Staff will ask for the Call ID when you are reporting issues with a specific phone call (i.e. call quality issues.)</td>
</tr>
</tbody>
</table>
Call Handling

Before we learn how to handle basic call functions in the Interaction Desktop, let’s review some notes about dialing numbers:

- Unless it’s an extension, dial the 10 digit phone number to make a call. Contact Center will ignore the 1 if you add it to the beginning.
- No need to dial “9” to get an outside line.
- Yes, you can still use the phone to dial the number manually.

Making a Call

You can make a call from Interaction Desktop by clicking inside the Number field and typing the phone number using your computer keyboard instead of dialing it on your telephone. Once you’ve entered the number, hit Enter on your keyboard to make the call.

Alternatively, if you’ve previously dialed a number you can click the down arrow to the right of the Number field and select one of the recently dialed numbers in the drop-down list.

Once you’ve selected the name/number, IC will automatically make the call. The call will appear in the My Interactions tab where you can see more info as the call progresses.

When either typing/pasting in numbers, you do not have to enter extra characters like ( ) or dashes like you might normally see. If you do, IC will figure it anyway. You can also type in vanity numbers. For example, you can enter 1–800–GOFEDEX and the call appearing in your My Interactions tab will show 1 (800) 463-3339 as the number dialed.
Commas in the number field cause a two-second delay and numbers typed after a slash are dialed only after a connection is made. For example 555-1212 /101,222 will first dial 5551212 and after connecting will dial 101, wait 2 seconds and then dial 2222.

When making a call, it will appear in your My Interactions tab. Note the following:

- Name and Number is basically showing caller id from the phone company.
- Duration of the call is incrementing as call progresses.
- State of the call is “Connected”.
- The Call Control buttons are filled with color as long as the call is highlighted meaning they can be used to control the call.
Picking up Calls
Interaction Desktop can notify you of incoming interactions by:

- Ringing your telephone
- Triggering a ring tone through computer speakers
- Popping the Interaction Desktop and/or the client “toast” to appear on top of any applications on which you are working

To pick up a call:

- Pick up your telephone handset (only if you are not connected to another call)
- Click the Pickup button on the call control toolbar
• Click the **Pickup** hyperlink on the toast popup.

![New Interaction](image)

Matthew Carbaugh
2558

- Pickup
- Send To Voice Mail
- Hold

Note: if auto-answer is configured for agents in their ACD queues, they will hear a tone in your headset and the call will be auto connected with no need to press anything.

When you have completed the call, it will be disconnected if:

- the other party hangs up first or,
- you hang up or,
- you press the Disconnect button on the Call Control toolbar.

Note the call state will change from Connected to Disconnected. Once disconnected a call will remain on your My Interactions tab for two minutes. It will then disappear and move to the Call History tab. Before it disappears, it is possible to redial that number by simply double clicking on the disconnected call.
Putting a Call On Hold
You can place the call on hold by clicking the Hold button on the call control toolbar. The caller will hear hold music while they wait on hold. To take the call off hold, click the Hold button again or double-click the call on hold. Once a button is clicked and the hold is in effect the button will appear pressed down.

Muting a Call
The Mute button silences your side of the conversation. You can still hear the caller but the caller cannot hear you. To remove mute click the Mute button again.

Transferring a Call
The Transfer button allows you to transfer a call to an internal or external number.
If you receive a call that needs to be transferred to another workgroup or party you can do that in many ways with the Client. Let’s first discuss a blind transfer. Select the call you want to transfer in your My Interactions tab and click the Transfer button or right-click the call and select Transfer from the shortcut menu.
The transfer dialog box appears.

In the Transfer To box when you begin to enter information, the dialog box will auto-populate a list of matches. You can type in an external number and the system will treat them accordingly. In this example, C- A-R...was typed and Matthew Carbaugh was selected.

After you select the transfer recipient, the Transfer dialog box displays the status information for your recipient, if he or she is an Interaction Desktop user. This can help you decide what kind of call transfer to use.

Interaction Desktop users can set Call Coverage options that forward their calls to another IC user. Interaction Desktop users can also set status details that forward their calls to an alternate phone number. Select the Override Call Forwarding check box to ignore these settings and transfer the current call directly to the selected number or voicemail box.

**Blind Transfers (Transfer a Call without Consulting the Recipient)**

Transferring a call without speaking to the intended recipient is called a blind transfer. Use a blind transfer if you do not need to speak with the recipient before transferring an interaction. If the intended recipient does not answer, the call is sent to the recipient’s voicemail.
Consult Transfers
Next we’ll discuss a Consult Transfer to another user. Let’s say that someone from Hinsdale has called and after speaking with them, you realize they really need to speak with Matt.

Rather than blind transfer the caller to Matt, we can Consult with Matt first to let him know the call is coming. Pressing Consult causes a screen like the one to the right to appear.

The buttons Neither, Caller, Consultant, and Both can be used to manage who you are speaking with at any point. When ready to transfer the call, hit Transfer Now to complete the transfer process.

Or, hit Cancel to stop the transfer. This will hang up on the caller you are consulting with and return you to the original caller.

Conferencing a Call

In Interaction Center 4.0, there are three ways to create a conference call, depending on the parties involved and your security permissions.
1. Drag and Drop: Used for conferencing external parties (i.e. callers who are not on the system.) To create a conference, place the current call on hold. Dial the outside number (or pick up the call from the outside caller.) When the second call is connected, highlight the call in your IC Client and, while holding down the left key of your mouse, drag the highlighted call and drop (release the left mouse key) on the top of the other call to create the conference.

2. Conference Button: Used for conferencing internal parties (i.e. callers who are in the company directory.) To create an internal conference, dial the number of a participant for the conference call. When this call connects, select a party from an IC directory and click the Conference button at the bottom of the directory. 

   Note: You may need to add the Conference button to the Directory toolbar. Instructions are given later in this document on customizing toolbars.

3. Join Button: Used to join an interaction in progress. If you have been granted rights to use the Join button, you may create a conference call by highlighting the call in another’s queue, and clicking Join. This will create a conference where all parties may hear one another.

The call will appear in the My Interactions window with the name “Conference”. A plus sign to the left of icon indicates clicking the plus sign will expand the conference call to view the participants. The plus sign then becomes a minus sign indicating the conference call is expanded. The Conference participant is you while the expanded participants are the other parties. If other parties need to be added to the conference you can
call them using the number field and once connected drag them into the conference. Other participants within the company can add participants to the conference as well. As a host you do not need to stay in the conference, you can hang up at any point. You can click on any participant and mute them, place them on hold, transfer them or disconnect them.

Notes about Conferencing:
When you’re in a conference, you can remain in the conference as long as you’d like. You can choose to disconnect at any time and the conference will continue.

If you need to return to the conference, call one of the remaining participants and have them drag you back in.

While in the conference, you have the ability to perform the same functions that are available in your My Interactions tab such as putting your connection on hold, muting your connection, and disconnecting your connection.

You can also perform these functions on another person’s object in the conference. If you have selected an object that is not your own, a prompt will appear notifying you that this is not your object and confirming if you wish to continue.

You can disconnect other participants from the conference.

If you want to ensure that the conference does not continue after you leave the conference, you will need to disconnect all participants before disconnecting yourself.
Call History
The Call History tab displays your history of inbound and outbound calls.
Your call history will show not only who called you or who you called but when and how long you talked. It also will show you calls you missed.

Call history information is retained for (7) days or (10) calls, whichever comes first, per user.

When a call disconnects, it stays in the My Interaction tab in a Disconnected state for a couple of minutes, then it is automatically moved to the Call History tab.

Similar to the My Interactions view, you may use the fields at the top of each column to conduct a search for a specific interaction.

To redial or call back from Call History Page:
Double-click the Call History row containing the number you want to dial.
Setting your Status

In order to receive calls, your status must be set to one of the Available statuses. Your status indicates how your interactions will be handled. Non-available statuses (Gone Home, On Vacation, etc.) will result in your calls going directly to voicemail. Even if you are logged into the system, your phone will not ring if your IC Client is set to a non-available status.

**Three Ways to Change your Status**

1. From the My Status area, click the down arrow and select a status from the drop down list in the My Status area of the Client.
2. From the System Tray (on the Windows Toolbar), right-click the client status icon in your system tray and select the status from the list.
3. From the Company Directory (not pictured) right-click your name in the directory and select ‘Change User’s Status’ from the sub-menu. This will open the Set Status dialog box that allows you to change your status.

**Setting Status Detail**

Some statuses will allow you to specify a time frame to provide information to callers and co-workers about when you may return to an available status. For example, if you know you will be in a meeting from 9:00am until 10:00am, you can click the Set status details link and set the time of your return. Another example is if you are going on vacation, you can click the Set Status Details link and set the time and date of your return.

The information in this time frame will be played (system audio prompt) to the caller, unless your Out of Office message has been activated (in which case your personal Out of Office greeting will be played to the caller). The caller will have the option to leave you a voicemail.
Using Directories

Directories are a list of agents or in the Employee tab, it is a list of University Employees. It contains columns like Last Name, First Name, Extension and Department.

From the Employee tab, you can:

1. Double-click a person’s name to call the person. Or, single-click the number hyperlink and click Yes on the pop-up to call the person.
2. Drag and drop a call to from ‘My Interactions’ to transfer the call
3. Search for a user:
   The blank boxes just above the column names are search fields. Enter the first few letters of the column entry (if it's alphabetical), or enter the first few numbers (if it’s numerical) in a search field. Columns that you cannot use for searches are indicated by "grayed out" search fields. (Example: Time in Status)

   Note: To clear any search field, hit escape while your mouse cursor is on any of the search fields.
4. Customize Columns (i.e. add Status columns)
   To add or remove a column from a page:
   1) Right-click on the column headings for the page. (A drop-down list of available column names appears.)
   2) Do one of the following:
      a) To add a column, click the name of a column.
      b) To remove a column, click the name of a column with a checkmark.

5. To reorder columns (i.e. display First Name column before Last Name):
   1. Click on a column heading.
   2. Drag it over the desired location.
   3. Release the column heading.

Note: Any changes made to a directory tab (i.e. addition or removal of columns, buttons, etc.) will only apply to that directory.
Customize Directory Toolbar

To customize a Directory toolbar:

1. Click on the tab containing the toolbar you want to customize. (i.e. Company Directory)
2. Right-click on the toolbar and select Customize.
3. In the Customize Toolbar dialog box, perform any of the following actions:

   To remove a button from the toolbar:
   
   From the Available toolbar buttons list, select a button name and click Add ->. Result: The selected button appears at the bottom of the Current toolbar buttons list.
   
   Tip: You can insert one or more Separator lines to divide the toolbar buttons into groups.

   To remove a button from the toolbar:
   
   From the Current toolbar buttons list, select a button name and click < - Remove.
   
   Result: The selected button is removed from the Current toolbar buttons list and reappears in the Available toolbar buttons list.

   To change the order of buttons on the toolbar:
   
   From the Current toolbar buttons list, select the button name and use the Move Up and Move Down buttons to move the button to the desired position on the toolbar.

4. From the Text options drop down list, control whether or not the button names are displayed by selecting Show text labels or No text labels.
5. Click Close to save the new settings or click Reset to return the toolbar to its default configuration.
Adding and Removing Views

The Employee tab within Contact Center is not the only directory within the system. You can add other directories or queues. Any of these can help you more quickly and easier place calls without having to stop and look-up a phone number in a separate application or other paper documentation.

To add additional pages, place your mouse on the active tab and right click. Select the New View command from the shortcut menu. The Create New View dialog box will appear. The Create New View dialog box is divided in two sides. The left side shows the categories and types of pages, while the right side lists the available pages for that category type. Click the checkbox to the left of the page you wish to add and then click the OK button of your dialog box. You will now see that page next to your other directories.

Alternatively, you may click the File menu at the top of the IC Client, and select New View… Once the view is selected in the Create New View dialog box, it will be automatically appear in the top Client tabs (near the My Interactions view.)

To remove a page, right-click the tab of the page you wish to remove and select Close <view name>. 
Accessing Voicemail

Voicemail is delivered to you by Contact Center via email and an attached .wav file. To access the offered email do the following:

1. Click on the pickup button or the link in the toaster pop-up (as shown previously).
2. Click on the attached .wav file
3. The file will play using your default audio player
4. Close the audio player
5. If you wish to save a copy of the message, forward the email to a department or your Harvard email address
6. To remove the email/voicemail click the disconnect button
   a. Note: messages are not saved by the Contact Center system
Hiding, Logging Out or Exiting the Client

There is a difference between hiding the Client and exiting the Client.

• When you hide the Client, it is still active and running in the background even though you do not see the Client window on your screen. You will still see the Client icon in your system tray. The Client window will appear when you receive an incoming interaction.
• When you exit the Client, it is no longer active and you will not receive interactions through the Client, although you may still receive calls through your phone or headset.

There are three ways to hide the Client:

• You can select Close (Hide) from the File menu.
• You can select Close from the telephone icon menu.
• You can click the Client window close button.

There are three ways to exit the Client:

• You can select Exit from the shortcut menu that appears when you right-click the Client icon in the system tray.
• You can select Exit from the telephone icon menu.
• You can select Exit from the File Menu.